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Design & Visual 
Communications I 
The following provides a record of the daily studio process.  
A typical studio meeting includes review of work in progress, 
introduction of new concepts, skill building, sketching and computer 
instruction.

Class 1: Monday

Introduction
Take Roll:  How do you want to be addressed? 
Hand around data sheet.
Introduce Myself:  Education, professional history & personality.
Class Process:  Drawing exercises (often one at the beginning of class).  Short 
lectures & demonstartions.  Small and large group presentations and discussions.  
Project and preliminary critiques.  Reading and writing.  Computer tutorials.  
Some time to work.  Breaks each day.
Class Attendance:  Attendance is not taken but it shows up in the completeness 
of your work.  Let me know why you are not here.
Reading:  Syllabi, Texts & Manuals.  I assume that you do the reading.  We may 
or may not discuss.  You are responsible for bringing up your questions.
Develop Friendships:  Some of the students in this class will likely become your 
best friends.  Personel relationships provide support and are a stronge predictor 
of success in college.
Make Yourself Known:  Ask questions and take part in class discussions.   
Talk with me.  Come to my office.
Class attendance and making yourself known builds good will with your 
teacher and classmates that can be drawn on when you have problems.

Key Beliefs
The inclusive beginnings program is based on the following positions.
1.  Studios should be conference rooms not drafting rooms; 
2.  Content should be focused through a few telling questions; and 
3.  Visual communication should be taught in the context of design.

Past Work
Review student work on the wall to give an overall view of projects for the year 
and quarter
Every one of you will be able to accomplish what you see on the wall.   
You will do it one step at a time. 
It is important that you take one step each day.
Questions?
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Process, Texts & Materials
Put in a notebook and always bring to class:   
Base Syllabus, 131 Syllabus, Drawing Form, Means to Ends.
Readings:   
Base Syllabus, First three chapters, pages 5 - 34 by next class.
Highlight & write in margins. 
Things that catch your attention or make you think? 
Things that need clarification? 
Things that cause concern?
Review In-Class materials.   
Collect & start bringing to class as soon as possible.   
Have for Wednesday:   Sketchbook, pen and soft lead pencil (e.g., 2B)

Break:  15 min.

Introduce Name Mnemonic Exercise
Describe the nature of a Mnemonic:  Toe Stew (Joe Steuer) 
Show examples:  Exaggerate & Integrate.
Divide the class into small groups. 
Talk Briefly about small group process and goals: 
Time limit and specific agenda. 
Accomplish task then talk.
Have groups work together to develop mnemonics for each other.   
Time limit: 20 minutes.
Preliminary mnemonic due next class. 
Reading:  131 Syllabus, Name Mnemonic, Pages 23-24.

What would make this class a better learning environment for you?
Make personal notes 
Time:  10 minutes
Divide into small groups and introduce yourselves.   
Share your personal notes.
Record on big sheets the three things that the group feels are most important for 
making this a positive learning environment. 
Time:  15 minutes
Hang on wall and Discuss
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Break:  15 min.

Visual Cues
Opening Comments:  We move around in the world and do not bump into things 
which indicates that we perceive the three-dimensional spatial relationships 
between things and ourselves.  If we want to create the illusion of three-dimen-
sional form and space in drawings we must represent the cues we recognize in 
the visual world on two-dimensional surfaces.  This project is about identifying 
the cues.  We will be exploring the representation of these cues in drawings abd 
computer images throughout this year.
Divide class into small groups. 
Introduce yourselves. 
Hand out photos. 
Each group is to identify three key qualities that contribute to the illusion of 
depth in your image. 
Letter key word for each quality on the sheet of paper provided 
Time:  10 min.
Hang photos and key word sheets on the wall. 
What are common qualities?   
What are unique qualities? 
Clarify qualities and identify terms. 
Time:  30 min.
Reading:  131 Syllabus, Visual Cues, Pages 25-27.
Reading: Drawing Form, Seeing & Drawing, Pages 7-21.
Preliminary:  Bring a photo.

Break:  15 min.

Computer Tutorial:  Class 01

Scanning
Analog To Digital talk.
Reading:  Photoshop Manual, Pages 13 - 19.
Scan an image at 75, 150 and 300 spi. 
Print each and bring prints and scans to class.
Bring Computers to next class.
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Class 2:  Wednesday

Name Mnemonic
Divide into small groups and introduce yourselves. 
Present mnemonic ideas and receive suggestions. 
Identify your favorite music and food.
Project selected examples on the wall and make observations & suggestions. 
Time:  About 30 minutes
Final Due Next Class with music & food info on the back.

Discuss Course Structure
Small groups to discuss Base Syllabus and 131 Syllabus readings. 
Things that you enjoyed or make you think? 
Things that need clarification? 
Things that cause concern?
Identify any questions or issues that you want me to address.   
Write them on the paper provided.  No names.  Collect the papers.
Time:  15 minutes.
Pass around class information sheet.
Respond to questions and issues. 
Focus on ethical guidelines on pages 25-26.
Time:  About 45 minutes

Break:  15 min.

Visual Cues
Develop a discription for one cue existing in your photo. 
Record in your sketchbook. 
Time:  4 min.
Reinforce function & value of small groups.   
What you put in will control what you get out.   
Practice at presenting ideas.   
Practice at listening, understanding and providing constructive criticism.   
Opportunity to share knowledge—to help each other with problems.
Small groups to present and receive feedback on description. 
Check correctness of concepts and clarity of statement. 
Each group is to choose one cue & image that was particularly clear and meets 
project requirements.  Record description on typing paper 
Time:  10 min.
Hang photos & discription on the wall. 
Discuss and offer suggestions for clarity and completeness. 
Time:  30 min.
Due Friday:   
Six cue statements in your sketchbook. 
Print or photocopy of image to hand in.
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Break:  15 min.

Shape Generation
Introduce the Shape Generation Project & Show examples.
Divide into small groups with the problem statement and your sketchbook. 
Read “Introduction” & “Design Constraints”. 
If you start with a 3” square using the subdivision approach, what are all the pos-
sible first lines that can be drawn?  Draw your ideas in your sketchbook. 
Time:  8 min.
Gather and draw alternatives on the wall. 
Time:  8 min.
Return to small groups:  If you start with one diagonal and one arc, what are the 
possible next moves?  Draw your ideas in your sketchbook. 
Time:  8 min.
Gather and draw alternatives on the wall. 
Time:  8 min.
Return to small groups:  If you start with a 1” square (multiplication), what are 
all the possible first lines that can be drawn that are different from subdivision?
Gather and draw alternatives on the wall. 
Discuss potential or implied lines. 
Time:  8 min.
Reading:  131 Syllabus, Shape Generation.
Due Next Class:  Generate six subdivision and/or multiplication designs on 
cross-section paper.

Break:  15 min



6B E N E D I C T
Arch 121 Daily2008

Computer Tutorial:  Class 02

Computer Basics
Operating system:  Keyboard Shortcuts 
Save & Backup 
Hierarchical Filing 
Problem Prevention 
Coping with Disaster
Read "Digital Tools" Pages 5-12.

Setup Unix Account.
Open Web browser & Enter URL: 
http://newemail.calpoly.edu/
At screen enter your Cal Poly ID# (998-99-9999) 
Enter your PIN# (usually MMDD e.g., 0101)
Hit Submit. 
Read Policy & Hit Yes. 
Enter Password twice.
Record your account info & save in a safe place.

Photoshop
Photoshop Interface:  Setup work environment, Save and Choose. 
Color Management:  Color Settings, Save & Choose.  Pages  7-12
Respond to scanning questions.
Upsampling & Downsampling.
Levels adjustment layers.
Auto Color adjustment.
Due Friday:  
Scan image at 75, 150 and 300 spi.  
Upsample 75, Downsample 300 and Leave 150. 
Image adjustment layer with Auto Color for all three files. 
Print all three files.
Read:  Photoshop Manual, Pages  7-12 & 21 - 28.
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CLASS 3:  FRIDAY

Name Mnemonic
Gather in a circle and have each person present their mnemonic.  After all have 
finished see if someone can remember all the names. 
Collect the mnemonics. 
Time:  20 min.

Visual Cues
Small groups.  Read another’s analysis, compare it with the image and make sug-
gestions for correctness, clarity and grammar. 
Time:  10 min.
Hang a variety of past projects on the wall.  Bring Sketchbooks.   
Get in small groups.
A key goal of visual design is to create relationships between elements.  Using 
the designs on the wall as examples, identify two specific ways that have been 
used to create relationships between elements.
Record key words that identify relationships on paper provided. 
Hang pages under appropriate example.
Observations, clarifications & Discussion.
Identify Design Means:   
Pattern, Hierarchy, Contrast, Balance. 
Proximity, Alignment 
Mood, expression, theme. 
Refer to Means to Ends, 
Time:  30 min.
Due Monday:   
Final Image (print of scan) and print of final six visual cues text.
Read/Review:  Means To Ends, Pages 15-38 (focus on page 17).

Break:  15 min.
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Shape Generation
Show checking process by tracing. 
Small groups to check the designs for following the rules.
Choose a good example of Symmetrical and Asymmetrical designs. 
Return to seats.  Project examples and clarify Symmetry.
Questions about project?
Due Next Class:  6 Multiplication and 6 Subdivision designs on crosssection 
paper that meet the design goals and the requirements.

Break:  15 min.

Computer Tutorial:  Class 03
Show suggested and required folder/file organization.
Documents/My Documents 
 131 Design 
  01 Project 
   01_Visual Cues 
   Visual Cues Process 
  03 Project 
   03_Hierarchy 
   Hierarchy Process

Photoshop
Computer Basics
Respond to scanning questions.
Image Mode
Cropping.
Undo & History Palette.
Due Monday:  
Scan image at 75, 150 and 300 spi. 
Save in PSD format 
Upsample 75, Downsample 300 and Leave 150. 
Image adjustment layer with Auto Color for all three files. 
Print all three files on coated paper. 
Print names on the back.  
File names:  alias_75-150.psd etc. 
Burn CD and print name on front of CD 
Will collect on Monday.
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CLASS 4:  MONDAY

Warm-up Exercise
Line & Value Exercises:  Syllabus Page 89. 
Time:  20 min.

Lettering Exercises
Hand Lettering: 131 Syllabus, Pages 74-75. 
Demonstrate lettering principles. 
Square versus skinny. 
Separate strokes for each part. 
Beginning and end to each stroke. 
Good Form:  Start vertical.  Refer to example in syllabus. 
Consistency:  Size, Shape, Alignment
Letter Example, page 75. 
Time:  30 min.

Break:  15 min.

Reading
Means To Ends, Because I Like It, Pages 7 - 11. 
Highlight Text:  Important Ideas or Things Needing Clarification.

Shape Generation
Small groups with alternatives. 
Check designs for correctness.
Hang all preliminaries on the wall and respond to any questions. 
Review requirements for final set.
Due Next Class:  
Complete Design Ideas: 12 Multiplication and 12 Subdivision. 
Final set of alternatives organized in final layout-Photocopy. 
In-class drawing equipment and materials.
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Visual Cues
Small groups to review three scans and CD burning. 
Review latest writeup for Visual Cues.
Collect Prints and CDs.
Discuss design process related to the project and what a thumbnail sketch is. 
Show thumbnail sketch and identify qualities.
Project a layout. 
Create a thumbnail sketch for the layout on typing paper. 
Hang on the wall and make comments.  Repeat.
Generate alternative layout thumbnail concept sketches for your presentation in 
your sketchbook. 
Time 30 min.
Due Next Class:  6 Thumbnail layout alternatives in sketchbook. 
Bring photocopy of sketchbook pages.

Break:  15 min.

Computer Tutorial:  Class 04

Freehand
Respond to questions.
Freehand Interface.
Due Next Class 
Read:  Freehand Manual, Pages 5 - 21.
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CLASS 5:  WEDNESDAY

Warm-up Exercise
Line & Value Exercises, Page 90 
Time:  20 min.

Reading
Means To Ends, Because I Like It
Hand out small sheets of paper.  Identify a layer and something about it that you 
found meaningful.
Gather together:  Set the first layer.  What does each layer mean to you working 
from inside out.  Discuss.
Collect papers.

Break:  15 min.

Shape Generation
Small groups to review proposed final set for variety. 
What qualities result in good variety? 
Choose best design from each proposal. 
What qualities do best designs share?
Hang final set proposals on the wall and share Variety and Design observations.
Show setup process for final design alternatives sheet. 
Make drafting suggestions:  Use of instruments, process and techniques. 
Layout and draft some design alternatives.
Time:  40 min.
Due Next Class:  Complete a minimum of one design without text on your 
proposed final sheet.

Visual Cues
Small groups to share conceptual alternatives. 
Work together to identify computer questions—what do you need to know to 
complete the assignment? 
Collect questions. 
Time:  15 min.
Due Next Class:  Preliminary:  Full size layout in Freehand with text, graph-
ics and image.  Bring color print to class.
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Break:  15 min.

Computer Tutorial:  Class 05

Photoshop
Answer questions.
Fade or adjust image for background use.
Save As in TIFF format both RGB & gray Scale for importing into Freehand.

Freehand
Importing images.
Creating Layers.
Working with grayscale TIFF images.
Copy and paste text.
Creating text styles.
Edit Styles:  Graphically/Redefine and Edit/Specifications.
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CLASS 6:  FRIDAY

Warm-up Exercise
Line & Value Exercises:  Create your own stream, Page 91. 
Time 20 min.
Lettering Exercise: 
Practice Lettering Shape Generation title block. 
15 min.

Break:  15 min.

Shape Generation
Divide the class into four groups:   
Bring final drawing prelim. 
Rotate drawings to the next group. 
Rank order in terms of craft. 
Note key words that identify quailities of good craft on paper provided.
Hang continuua & key words on the wall. 
Make observations. 
Any Questions?
Due Next Class: 
Final Project Submittal.

Visual Cues
Small groups to present layouts.
Note computer questions on paper.
Hang preliminaries on the wall. 
Collect questions.
Review project requirements. 
Any design ideas that caught your attention?
Due Next Class:   
Continue to develop your design.   
Bring color print to class.
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Computer Tutorial:  Class 06

Computer
Respond to questions.

Freehand
Guides & Snaps.
Creating Text Blocks & Text Entry.
Edit Styles:  Graphically/Redefine and Edit/Specifications.
Flowing text between text blocks. 
Break link by dragging to open area.
Text > Special Characters > End of Column.
Text block rotation.
Creating paths in Freehand. 
Drawing Lines, rectangles & polygons. 
Filling and stroking paths.
Sample color from image: Xtra Tools > Eyedropper



15B E N E D I C T
Arch 121 Daily2008

CLASS 7:  MONDAY

Lettering Exercises
Cross section grid paper. 
Copy the backing sheet info on page 74 of the 131 Syllabus. 
Time:  10 min.

Shape Generation
Divide class into groups with final designs. 
Bring a colored pencil. 
Exchange one copy of final designs between groups.
Evaluate the designs for rule compliance. 
Mark successful designs with a check. 
Mark designs with problems with a question mark. 
Time:  20 min.
Return sheets to owners to check questioned designs. 
Do you agree.  Discuss in groups to clarify. 
Examine your original designs with each other in terms of craft.
Collect final submittal.

Reflections
On a fresh page in your sketchbook:   
Do not letter near edge of page (e.g., with 1/2") 
Write so that I can read. 
Put your name at the top of the page. 
Project Name 
Time spend since class on Friday. 
One thing you learned for the preliminaries. 
Two important things you learned from the project.
Due Wednesday:  Photocopy of sketchbookreflections.
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Break:  15 min.

Drawing
Introduce Drawing project. 
Weekly Drawings, Sketchbook, Gesture Drawings
Introduce weekly drawing components and constraints. 
Drawing, Backing Sheet, Compositional Alternatives.
Introduce First weekly drawing.  Show examples and reinforce: 
Three dimensionality all year. 
Drawing focus on Light this quarter. 
Expression versus photograph. 
Amplifying the qualities you want to communicate.
This is your first drawing.  It is a bench mark of where you are.   
Just do your best and do not worry.
Due Next Class:  Drawing 1:  Feeling Light. 
Read:  Drawing, Pages 67 - 81
Must have Newsprint pads & black markers by Friday 

Drawing Exercises
Blind Contour drawing. 
Draw hand with pencil through paper (four minutes). 
Lesson:  Seeing physical properties.   
Not drawing from what you know. 
Time 20 min.
Show examples of compositional sketches 
Do compositional sketches from projected images. 
3 minuters each.
Seeing color and representing value. 
Seeing surface value and representing illumination level.
Upside down drawing from Power Point show (eight minutes). 
Lesson:  Looking without naming. 
Drawing lines that have a shape and location. 
Time:  20 min.
Drawing strategies from Power Point show 
Frame of Reference and Grid. 
Frame of Reference and Regulating lines.
Choosing what to draw. 
Creating the frame of reference. 
Subdividing the frame of reference. 
Working within the framework.
Readings
Design Drawing:  Pages 13 - 63.   
Highlight most interesting passages.  Note questions.
Design Drawing CD:  Look at “Drawing Techniques”
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Computer Tutorial:  Class 07

Computer
Respond to questions.

Freehand
Clipping Path, Edit > Cut, Edit > Paste Inside.
Changing a portion of a paragraph to a different color. 
Easy:   
Highlight letters and drag in the desired color.
More Sophisticated: 
Duplicate the original text style(s) and change the color specification as desired. 
Create a new layer and clone the text block and move it to the layer. 
Apply the adjusted style to the cloned text.
Draw a closed path that defines the line of change and includes the text to be 
changed.  Align the closed path to the text. 
Set fill and stroke to None.
Select and Cut the text. 
Select the path and choose Edit > Paste Inside.
Individual help.



18B E N E D I C T
Arch 121 Daily2008

CLASS 8:  WEDNESDAY

Warm-up Exercise
Line & Value Exercises:  Cubes Page 92 in Syllabus 
Time 30 min.

Weekly Drawings
Present drawings in small groups. 
What did you see and were trying to communicate? 
Feedback:  How did they do & offer suggestions for improving communication. 
Time:  6 min.
Hang all drawings on the wall—Bring sketchbooks. 
Make a Thumbnail and note two reasons that it communicates feeling of light. 
Turn to neighbor to share observations. 
Share observations with the class.
These group sessions will be the primary source of feedback on your weekly 
drawings.  Come and talk with me individually for further feedback. 
I will put a grade on the drawings and make a few general observations during 
our next class. 
Time:  30 min.
Collect drawings & Compositional Alternatives.
Collect Reflections
Must have Newsprint pads & Markers by Friday

Break:  15 min.

Hierarchy
Read the project statement. 
Give an overview.
Hang sets of past Hierarchy designs on the wall. 
Choose a pair and make thimbnails in your sketchbook. 
Which one is more successful and why.
Share observations with the class.
Discuss design goals for the project. 
Balance of Weight & Motion. 
Implied and Explicit shapes and patterns. 
Multiple patterns or objects. 
Hierarchy of shapes and patterns. 
Typography that extends and enhances without overpowering. 
Time:  30 min.
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Hierarchy
Use copy of Shape Generation final and trash. 
Generate design alternatives. 
Time 10 min.
Due Next Class:  
Scan photocopy of Shape generation Final 
Print three copies and generate alternatives. 
Bring file and prints to class.
Reading:  131 Syllabus, Hierarchy

Break:  15 min

Computer Tutorial:  Class 08
Respond to questions.

Photoshop
Clipping paths in Photoshop.
Time to work & Individual questions.
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CLASS 9:  FRIDAY

Big Friday Drawing
Pad oriented vertically. 
Do exercise. 
Initials and number in lower right hand corner. 
Hang and Observations after each sketch.
Proportions:  Black marker. 
Draw a square and divide it into a one-third grid. 
3 x 4 rectangle and divide into one-quarter grid.
3 x 4 Rectangle and one-quarter grid for projected image. 
Four minutes to sketch image with black marker.
Rectangle and four regulating lines for projected image. 
Four minutes to sketch image with black marker.
Keep last two & put Initials & date in the corner.

Weekly Drawings
Return last drawing. 
Show examples and make comments. 
Good overall drawing care and quality. 
Discuss grade notes. 
Time:  20 min

Break:  15 min.

Paraline Drawing System
Introduce Paraline drawing system.
Introduce Paraline drawing principles, rules and conventions—X, Y, Z axis. 
Lines parallel to axis versus oblique to axis. 
Draw three cubes (Axo, Iso, Plan Oblique) 
Lin graphic language.  Shading approach. 
Time 50 min.
Reading:  Design Drawing pages 173 - 191. 
Review CD section on paraline drawing.

Break:  15 min.
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Visual Cues
Small groups to share designs. 
Describe your organizing idea for the design. 
Feedback:  Clarity and consistency of response to organizing idea. 
Record computer questions on paper.
Hierarchy:  How does you eye move around each other's projects.  Whay attracts 
your eye first, second, third.
Hang projects on the wall. 
Collect Questions.
Sketchbooks:  Thumbnails and reasons for two very successful designs. 
Turn to neighbor to share observations.
Record how many chose which designs as very successful. 
Why were these chosen?  Discussion.
What should be the visual hierarchy?
Point out the design concepts that are being used to produce success. 
E.g., Pattern, Hierarchy, Contrast, Overall Theme or Expression, etc. 
How is relationship being achieved?
Due Next Class:   
Final Project Submittal.

Break:  15 min.

Hierarchy
Small groups to share alternatives. 
Identify any project questions. 
Gather and respond to questions.
Due Next Class:  
Construct Straight Line Subdivision design in Freehand as described in the 
handout.  Bring print.
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Computer Tutorial:  Class 09

Questions
Respond to any questions related to Visual Cues final.
Cropping to a specific size and resolution with the crop tool.
Clone tool use.

Photoshop
Open Scan 
Make Grayscale  
Adjust Values with Levels.
Straighten Scan: 
Choose Ruler tool under Eyedropper tool. 
Draw a line that should be horizontal or vertical. 
Choose Image > Rotate Canvas > Arbitrary 
Choose direction and click OK.
Crop design:  Straight Line. 
Enlarge/Scale by 200%. 
Save As in TIFF format.

Freehand
Setting up construction page. 
Rename Foreground layer "Design." 
Setting grid size and dragging in guides. 
Importing scan and placing on Background layer. 
Coloring scan if desired.
Turn on snap to grid. 
Construct lines with the Line tool on the Design layer. 
Turn off snap to grid and turn on snap to points. 
Construct lines with the Line tool.
Magnification & Keyline view to achieve accuracy. 
Work at consistent % enlargement (3200%)
Use the Knife tool to cut lines at their intersections.
Lock the Design layer.
Create a new layer named Medium and make it active. 
Choose the Line tool, 
Set the Stroke to 6 points. 
With Point Snap on Trace segments.
Create a new layer named Heavy and make it active. 
Choose the Line tool, 
Set the Stroke to 18 points. 
With Point Snap on Trace segments.
Individual Help
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CLASS 10:  MONDAY.

Visual Cues
Reflections: 
Time since Friday. 
2 valuable computer things you learned 
2 valuable design things you learned.
Hang all presentations on the wall. 
Note in your sketchbook:  Thumbnail and three reasons.
Best Relationship:  Design with a strong organizing concept—relationship be-
tween its elements.
Best Hierarchy:  Design with a clear visual hierarchy.
Best Expression:  Design with a clear visual mood, feeling, expression.
Share observations with a neighbor.
Importance of three design issues.
What changes made since Friday that improved the designs do you see?
Time:  30 min.
Collect final submittal.
Collect Photocopies for reflections next class.

Shape Generation
Return projects and grades. 
Make overall comments.

Break:  15 min.

Weekly Drawings
Introduce drawing #2. 
Review drawing goals and constraints using examples on the wall.
Exercise:   
Trace cyllinder on page 99 of the Workbook twice on a page in your sketchbook.  
Discuss value structure of the illustration. 
Interpret the illustration as a four value drawing. 
Exchange the values as you would in Drawing 2.
Due Wednesday:  Drawing #2

Break:  15 min.
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Hierarchy
Small groups to present your alternatives. 
Give feedback to each other.
Record computer questions on paper.
Due Next Class: 
Straight line design and one other design with line weight hierarchy. 
Bring prints to class.

Break:  15 min.

Computer Tutorial:  Class 10

Freehand
Respond to questions and problems that were encountered in preliminaries.
Magnification & Keyline view to achieve accuracy. 
Work at consistent % enlargement (3200%)
Use the Knife tool to cut lines at their intersections.
Lock the Design layer.
Create a new layer named Medium and make it active. 
Choose the Line tool, 
Set the Stroke to 6 points. 
With Point Snap on Trace segments.
Create a new layer named Heavy and make it active. 
Choose the Line tool, 
Set the Stroke to 18 points. 
With Point Snap on Trace segments.
Cut and join lines as needed. 
Set Mitre limit. 
Set width & End condition.
Create line styles. 
Edit line styles.
Cutting paths. 
Closing paths.
Scaling a line. 
Both ends (select the line) 
One end (select the handle)
Circle Tool, (Shift + option) 
Fitting circles using scale function.
Circles/Arcs at odd angles. 
Make the center of the circle 0,0. 
Draw circle from center with Shift + Option/Alt. 
Double click on Scale tool to open dislog box.
Ungrouping circles and squares. 
Split lines at handles. 
Cutting lines, circles and arcs (Knife Tool).
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CLASS 11:  WEDNESDAY

Graphic language
Sheet for techniques. 
Graphic language for soft lead pencil:  Fuzzy Line, Repeat Line, Hit-Go-Hit, 
Professional Gap, Professional Dot, Overlap Corners. 
Line weights for Pen.
45° Shading, Gradual Value Change for orientation to light.
Discuss line weight and shading conventions. 
Sketch and shade a cube.
Reading:  Drawing Form:  73 - 91

Axonometric Drawing
Draw together:  Build cube form from one cube that includes sloped planes. 
Draw together:  Large cube with a 1/4 grid on all surfaces. 
Individual designs:  Wor within large cube based on grid lines.  Include sloped 
(45°) planes.

Break:  15 min.

Weekly Drawing
Small groups to present drawings. 
Hang all drawings on the wall. 
Choose two drawings are successful compositions and identify why. 
Share observations. 
What did you learn from this exercise.
Time: 30 min.
Collect drawings.

Hierarchy
Small groups to present your alternatives. 
Give feedback to each other.
Hang designs on the wall. 
Choose one that you thing is visually successful. 
Thumbnail and Note two reasons why.
Record votes on wall. 
Why were these chosen?  What qualities do they share? 
Discuss and make observations.
Response:  
Do they exhibit three distinct line weights?  
Do they exhibit implied shapes or Patterns? 
Do they exhibit a balance of weight and motion?
Due Next Class:  
Final preliminary. 
Bring print.
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Computer Tutorial:  Class 11
Rotate text. 
Binding text to paths.
Path Direction: Modify > Alter Path > Reverse Direction
Attaching text to paths. 
Aligning text and paths.
Full design on a source layer. 
Cloning and moving needed lines to appropriate layer.
Individual Help
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CLASS 12:  FRIDAY

Big Friday Drawing
Gesture drawings from projected images. 
Two minutes per drawing. 
Mouse: Continuous scribble. 
Mouse:  Again 
Play Sculpture:  Lines express qualities. 
Play Sculpture again. 
Yellow House:  Minimum marks. 
Yellow House:  B;ack areas. 
Media:  Black Marker. 
Initials & number in the corner.

Weekly Drawings
Introduce weekly drawing #3 and show examples. 
Emphasize detail in perimeter of areas. 
Go out with class point out sun, shade, shadow surfaces.
Find a subject and make a drawing in your sketchbook. 
Return in 30 min.  15 min for drawing and 15 min for break.

Break:  30 min.

Weekly Drawings
Show selected sketches and make comments. 
Make comments.
Return last drawings. 
Show examples and make comments.

Circles in Paraline Drawings
Drawing circles on 60/30 plan oblique surfaces. 
Top, 30° side then 60° side. 
Reference:  Ching 176.
Time:  30 min.

Break:  15 min.
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Hierarchy
Divide class into four groups. 
Bring prints of final preliminarues. 
Exchange sets of drafted designs between groups.
You are to arrive by consensus at a ranking of the designs that you have been 
given from the most to least visually pleasing. 
Time:  5 min.
How can you use the continuum to teach something about design? 
What quality assisted you in ranking the designs that can be turned into a 
lesson about creating more successful designs?
Plan your lesson. 
Time: 5 min.
Hang ranked sequences on the wall. 
Each group is to choose someone to present their lesson.
After all groups have finished ask if there are any patterns that can be seen when 
comparing all the sets. 
Discussion. 
Time: 20 min.
Due Monday: 
Final prints, File on Disk, Grade Sheet.

Form & Space
Bring copy of your Shape Generation final designs.

Computer Tutorial:  Class 12

No computers next week.

Freehand
Respond to questions and problems that were encountered in preliminaries.
Controling path ends. 
Moving line ends.
Make Ends layer. 
Black areas. 
White areas
Show Final submittal example.
Respond to questions.
Those that have specific computer problems are invited to stay to work on solu-
tions.
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CLASS 13:  MONDAY

Axonometric Drawing
Setup 30/45 axonometric drawing in sketchbook 
Create a 3” cube. 
Create a subdivision design of straight lines on one vertical face. 
Use design to cut into cube to create a three-dimensional sculpture. 
Finish with line weight and shading. 
Draw Orthographic drawings of the design. 
Time 40 min.

Visual Cues
Retirn project evaluations. 
Review craft issues by showing an example. 
Hang projects on the wall and make observations. 
Hand out grade sheets.

Break:  15 min.

Hierarchy
Hang final designs on the wall. 
Choose the two most visually interesting solutions. 
Record votes on paper by designs. 
What qualities do the ones receiving the most votes share? 
What does this teach us about design? 
Discuss. 
Time:  20 min.
Collect Final Submittal.

Reflections
Note in your sketchbook: Good lettering. 
Draw line:  Hierarchy above, Name and hours below. 
One thing you learned from the preliminaries. 
One thing you did that was helpful in solving the problems. 
Three most important things that you learned from the Hierarchy project. 
Time:  15 min.
Due Wednesday:  Photocopy of reflections.

Break:  15 min.
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Weekly Drawings
Review drawing requirements.
Due Wednesday:  Drawing # 3

Form & Space
Introduce Form & Space project. 
Show past examples.
Divide the class into small groups. 
Bring sketchbook and first two pages of project statement. 
Each group is to diagrammatically illustrate the project constraints—make the 
rules visible.  You must visually illustrate how to develop a  
Column,  
Wall,  
Positive Volume,  
Negative Volume. 
Time:  10 min.
Review the constraints and draw diagrams to illustrate. 
Explain Design Options. 
Time:  10 min.
Siting Designs. 
Show process:  Site lines in red, Trace design on site, Extend lines. 
Everyone is to site one of their designs and extend lines. 
Hang on the wall and comment.
Due Wednesday:  Read project statement. 
Bring copy of two of your final Shape Generation designs at 6" size.  Multi-
plication designs must be sited.
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CLASS 14:  WEDNESDAY

Orthographic Drawing System
Introduce Orthographic drawing system. 
Orthographic relationships.
Time 10 min.
Reading:  Design Drawing pages 123 - 133. 
Review CD section on orthographic drawing

Visualization Puzzles
Introduce Visualization Puzzles. 
Talk through discovery process. 
Layout (Pencil), Edges (Pen), Shade (Prismacolor) 
Promary & Secondary line weights & Sun shading assumptions. 
Work on solving first puzzles.
Work on Visualization Puzzles. 
Pages:   
Time: 30 min.

Weekly Drawing
Small groups to present. 
Hang drawings on the wall.
Indentify one successful composition and note why? 
Discuss observations with neighbor. 
Share observations with class. 
Time: 30 min.
Collect drawings.

Hierarchy
Collect reflections.

Break:  15 min.
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Direct Perspective
Introduce Perspective Continuum and the point of view that drives its organiz-
ation.
Overview od elements of perspective:  Observer SP, Picture Plane, Subject, Hori-
zon Line.  The eye of the observer sets the location of the Horizon line.
Basic Principles of Direct Perspective (23-28).
1:  Things get smaller as they are farther from us. 
2:  All edges and surfaces parallel to the face of the observer/picture plane retain 
their true shape and proportions. 
3:  Surfaces and edges not parallel to the face of the observer/picture plane are 
foreshortened. 
4:  Sets of parallel edges appear to converge to a common point. 
5:  In one- and two-point perspective vertical edges remain vertical.
Sketching Cubes
Sketch a two-point cube in perspective. 
Sketch a one-point cube in perspective. 
Sketch other cubes.  What are their relationships?  The world has and our draw-
ings can have multiple vanishing points. 
What looks right—what looks like a cube?
Draw a horizon line and vanishing points in the middle of the page and fill the 
page with two-point cubes of different sizes. 
Draw the perspective field and note distortion of cubes that fall outside. 
Discuss limits of lineal perspective system and concept of cone-of-vision as lim-
iting guide.
Time:  50 min.
Due Friday:  Read “Drawing Form” Pages 23 - 28. 
Look at perspective sections on Design Drawing CD

Break:  15 min.

Form & Space
Questions about problem statement? 
Show past work and discuss goals.
Orient 200% design and add vertical axis. 
Overlay with trash and draw: 
Wall, Column, Beam, + Volume, - Volume. 
Draw in class based on your design. 
I will circulate and answer questions.
Show use of insstruments and drawing board to develop drawing.
Due Friday:  
Two 200% designs. 
One design alternative
Art Stix by friday.
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CLASS 15:  FRIDAY

Warm-up Exercise
Work on Visualization Puzzles. 
When you complete series continue to next.  Read instructions. 
Time:  20 min.
Look at some solutions & make drawing comments.

Big Friday Drawing
Warmup with ArtStix. 
Gesture drawings from projected drawings. 
Focus on surface quality of subject and media. 
Time:  4 - 5 minutes each. 
Media:  Prismacolor ArtStix. 
Initials & number in the corner. 
Hang images on the wall for quick observations. 
Repeat Process.

Break:  15 min.

Weekly Drawings
Hand back drawings. 
Make observations.
Introduce Drawing 4 
Show past examples.

Direct Perspective
Show Ching CD sections on perspective.
Introduce the concept of Center of Vision and pointing at Vanishing Points.
There is only one CV and it is the VP for all One-Point cubes in the perspective.
Draw a horizon line and vanishing point in the middle of the page.   
Draw 5 one-point cubes of different sizes around page. 
Add one point cube at an angle. 
Add two two-point cubes with different VPs.
Draw a horizon line and vanishing point in the middle of the page. 
Draw one one-point cube. 
Find diagonal vanishing points for the cibe and use them to construct additional 
cubes.  Introduce idea of oblique lines and their VPs. 
Add four other cubes to the page using the DVPs.

Break:  15 min.
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Form & Space
Overlay 2D design with trash and shade in Major space and indicate entry path.
Small groups to present and review design ideas. 
Check each other’s drawings.
Hang on wall. 
Discuss the six design issues. 
Discuss the scale of the space and mark it off in class. 
Answer questions.
1:  Is the major space partially or completely hidden as you approach and enter?
2:  Is there an entry experience that envolves time and space?
3:  Does the entry experience enhance the arrival experience?
4:  Is there a major space with a clear figure?
5:  Does the experience of turning in the major space range from open to closed?
6:  Does the design include spaces that range form implied to explicit?
Due Monday:   
Final 2D design carefully constructed by hand or using Freehand 
Developed plan oblique proposal on trash.
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CLASS 16:  MONDAY

Warm-up Exercise
Work on Visualization Puzzles. 
When you complete series continue to next.  Read instructions. 
Time:  20 min.

Hierarchy
Return evaluations for Hierarchy project. 
Hang work on the wall.  Make key points 
Hand out evaluations.

Break:  15 min.

Weekly Drawings
Introductory exercise:  Draw a portion of the teaching station using the language. 
Show under camera & make observations.
Due Wednesday:  Drawing #4

Direct Perspective
Present why the Fundamental Techniques are valuable.
Draw together:
Horizontal Transfer 
Distribute 
Add One 
Multiply 
Subdivide
Draw together in the sketchbook. 
Create a stack of cubes using previous concepts. 
Use techniques to extend the stack in all directions. 
Time: 15 min.
Start with a single cube. 
Create a stack of cubes using previous concepts. 
Use techniques to extend the stack in all directions. 
Time: 15 min.
Due Wednesday:  Read “Drawing Form” Pages 29 - 34
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Form & Space
Small groups to discuss project constraints/goals and plan oblique drawing. 
Hang preliminaries on the wall. 
Make a dimensioned sketch of your major space in your sketchbook. 
Mark off some of their spaces in the clossroom using people. 
Reinforce understanding of design proposals by finding similiar spaces.
Respond to issues from small groups. 
Discuss design goals:  Major space; Entry.
Show and discuss ways of defining space.
Due Wednesday:   
Make progress on your design.
Due Friday:  Final Preliminary. 
Plan oblique drawing on trash or velum.

Break:  15 min.

Computer Tutorial:  Class 16

Freehand
Demonstrate the use of the expand and offset tools.
Expanding set of lines to create forms. 
Select Line. 
Choose Operations > Expand Stroke. 
Set width & End condition. 
Click OK. 
Choose Path. 
Line to 1pt black & Fill to None. 
Choose Modify > Split & discrad unneeded path. 
OR 
Select Operations > Inset Path. 
Enter dimension & Corner condition. (minus numbers expand). 
Click OK.
Trace existing points with snap to points to create shape.
Boolean operations to join elements or make new ones.
Adding and removing points to make footprint.
Controling printing of invisible layers. 
Choose Setup > File > OutPut Options.
Bring computers next class.



37B E N E D I C T
Arch 121 Daily2008

CLASS 17:  WEDNESDAY

Mid-Term Evaluation
Hand out mid term evaluation Form. 
Fill out form:  No names. 
Small groups to share thoughts. 
Star by consensus important issue in each. 
Identify one question. 
Gather and respond to questions form each group.
Collect individual forms.

Weekly Drawing 
Hang on wall. 
Make thumbnail & notes in your sketchbook to identify: 
Successful Figure ground ambiguity. 
Capturing unique qualities of subject.
Balance of black and white. 
Interaction with border. 
Object floating within black area.
Collect drawings and compositional alternatives.

Break:  15 min.

Form & Space
Plan Oblique Drawing 
Hand out copies of materials. 
Page Layout:  11 x 17 copy paper to do layout together. 
Typography:  Tracing title and hand lettering. 
Graphic scales 
Line qualities 
Line weights
Drafting Issues: 
Layout with hard lead pencil. 
Raising triangles above paper. 
Keeping paper clean for inking. 
Ink in sequence.
Exploration: 
Develop the footprint for the most complex connections that you have in your 
design.  Use trash over the Freehand design print.
Due Friday:  Final preliminary plan oblique 
Final Freehand 2D drawing print.

Break:  15 min.
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Computer Tutorial:  Class 17

Form-Z
Installing Form-Z 
Creating the Form-Z environment. 
Loading Preferences, Tools and Short Cuts.
Due Wednesday:  Form-Z running with preferences loaded.
Bring Computer.
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CLASS 18:  FRIDAY

Big Friday Drawing
Gesture drawings from projected images. 
Continuous line scribble. 
Time:  2 minutes each. 
Media:  Black Marker. 
Initials & date in the corner. 
Hang images on the wall for quick observations. 
Repeat Process.

Break:  15 min.

Weekly Drawings
Return drawing #4 
Comments:  Keeping detail in contours. 
Cropping to strengthen composition and effectiveness of Positive/Negative.

Form & Space
Small groups to present drawings. 
Look for drawing problems and suggest corrections.
Hang drawings on the wall. 
Ask for questions and make comments.
Draw the footprint of the most complicated connection in your design. 
Show how each connecting element will be shaped with a series of overlays.
Suggestions for repairing drawings: 
Using erasing shield and proper eraser.
Due Monday:  Final Submittal: Monday

Break:  15 min.

Computer Tutorial:  Class 18

Form-Z
Creating the Form-Z environment. 
Loading Preferences, Tools and Short Cuts. 
Demonstrate the process for each.
Beginning orientation to form-Z
Bring computers Next class.

Form & Space
Answer questions. 
Personal help.
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CLASS 19:  MONDAY

Weekly Drawing
Introduce drawing #5 
Discuss assignment and show examples. 
Hand out black paper and use church slide. 
Make a light drawing of the church using white Prismacolor pencils. 
Time:  8 min.
Hang drawings on the wall and make observations. 
Time:  10 min.
Due Wednesday:  Drawing #5

Mid-term Evaluation
Respond to evaluations.

Break:  15 min.

Form & Space
Place grade sheets and plan oblique on desk. 
Work on reflections as I check off drawings and collect grade sheets.
Reflections. 
Time spent since last class. 
2 things learned form preliminaries & process. 
3 things you learned from the project. 
Each person share something.
Small groups to check each others drawings. 
Construction accuracy and line language.
Suggestions for repairing drawings: 
Using erasing shield and proper eraser. 
Using Knife.
Collect Digital Files & Freehand prints.
Due Wednesday:  Final Submittal: Wednesday

Re Presentation
Introduce the project.
Due Wednesday:  Read project statement. 
Bring 8x8 Cross Section grid paper.
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Break:  15 min.

Computer Tutorial:  Class 19

Organization
Create a new folder name it 05_RePresentation.
Create a new folder RePresentation_Process

Form-Z
Complete setup of environment.
Review basic form-Z concepts. 
All things are build relative to the active reference plane.
Save the file as wbenedic_space.
2D Design
Rename the default layer "Design. 
Set Object Modifier to 2D Line 
Choose the approipriate Tool 
Drawing lines and arcs. 
Object type and resolution. 
Using Grid Snap and Object Snap functions.
Review and bring pages 1 - 72 of the Form-Z Manual to class.
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CLASS 20:  WEDNESDAY

Direct Perspective
Review first four fundamental techniques.: 
Draw together in the sketchbook. 
Create a stack of cubes using previous concepts. 
Use techniques to extend the stack in all directions. 
Time: 15 min.
Draw in your sketchbook. 
HL in the middle of the sheet with VPs 10” apart. 
45° two-point perspective—lead edge in middle.
You must add a minimum of nine more cubes. 
They must move up, down, front, back, left and right from original. 
Creating a three-dimensioal cubic sculpture. 
Use all concepts discussed to date. 
Add line weight and shading to finish drawing.

Weekly Drawings
Share drawings in small groups. 
Hang drawings on the wall. 
Which drawings most clearly have a sense of light. 
Best composition?
Collect Drawings and compositional alternatives.

Break:  15 min.

Form & Space
Shading Plan Obliques. 
Review requirements and show examples. 
Shade Cylinder from Drawing Workbook. 
Shade using Black and Sepia/50% French Gray pencils. 
Smoothness of texture.
Experiment with combining Black and Sepia. 
Shade Plan Oblique drawing. 
Time:  20 min.
Due Friday:  Shaded Plan Oblique

Re Presentation
Introduce process and answer questions. 
Show layout requirments for plan sheets. 
Drawing Roof Plans. 
Time:  30 min.
Due Friday:   
Original Roof Plan. 
2D design constructed on a Design layer. 
Min. of two forms on Form layer. 
Bring print and digital file.
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Break:  15 min.

Computer Tutorial:  Class 20

Form-Z
Review construction strategies of positive elements.
Create a new layers called Work and Form. 
Put them in order from top to bottom:  Form, Work, Design. 
Lock the Design layer.
Create A Basic Wall
Make the Work layer active (Check). 
Choose Top Axonometric view 
Choose a Surface Style/Color. 
Set Object Modifier to 2D Enclosure, Options:  Facetted 2' wide. 
Choose the Vector Line tool. 
Turn on appropriate snaps. 
Trace the line to create the footprint. 
Enter "E" to end the drawing. 
Choose the Extend tool.  Set Options to Segment At 1' From Point 
Click on ends to extend footprint. 
Activate the Form layer. 
Choose the Layer tool and click on the wall. 
Choose 30/60 Axonometric view 
Choose the 3D Extrusion Derivative tool. 
Click and drag to appropriate height. 
Render the image.
Create A Basic Volume
Trace the set of lines. 
Use the Parallel tool to expand or retract.
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CLASS 21:  FRIDAY

Big Friday Drawing
Gesture drawings from projected images. 
Continuous line scribble. 
Time:  2 minutes each. 
Media:  Black Marker. 
Initials & date in the corner. 
Hang images on the wall for quick observations. 
Repeat Process.

Weekly Drawings
Return drawings. 
Make comments.
Collect drawings that are on the wall.
Due Wednesday:  Final Set Due.

Break:  15 min

Form & Space
Hang drawings on the wall. 
Make observations. 
Collect shaded Plan Obliques.

Re Presentation
Hang orthographic drawings on the wall. 
Make observations. 
Review requirements and show process for creating elevationss. 
Review construction of floor plans 
Review use of section lines, North arrows, etc. 
Review use of dashed lines to indicate overhead elements in floor plan.
Work on Drawings.
Write down questions on computer process.
Due Wednesday:  Preliminary set of orthographic drawings.

Computer Tutorial:  Class 21
Answer questions.
Review construction strategies of positive elements.
Due Wednesday:  Progress on Model
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MonDAY:  Holiday
If the holiday falls on Tuesday, use Monday as an extra day to check orthographic 
drawings and work on digital model.

Drawings
Small groups to check correctness of plans and elevations.

Computer
Gather questions & do tutorials.
Work on your models.
Due Wednesday:  Preliminary set of orthographic drawings. 
Progress on Model.  Final weekly drawing set.



46B E N E D I C T
Arch 121 Daily2008

CLASS 22:  WEDNESDAY

Warm-Up Exercise
Work on Visualization Puzzles. 
Do any that look interesting and challenging. 
Time:  20 min.

Form & Space
Return projects and discuss grades.

Weekly Drawings
Arrange the drawings on your table. 
Circulate and enjoy the drawing show.
Three things that you learned from this project. 
Share with a neighbor. 
Share with the class.
Collect Final Drawings 
Collect Reflections

Break:  15 min.

Direct Perspective
Draw in your sketchbook. 
HL in the middle of the sheet with VPs 10” apart. 
45° two-point perspective—lead edge in middle. 
6” cube with lead edge starting 1.5” below the HL 
2.5" to the sides of the cube.
Subdivide large cube to create form.
Subdivide the faces of the cube. 
Creating a three-dimensioal cubic sculpture. 
Add line weight and shading to finish drawing.

Re Presentation
Small groups to review correctness of orthographic drawings. 
Hang drawings on the wall. 
Make comments. 
Respond to questions.
Due Friday:  Orthographic drawings on cross section paper.

Break:  15 min.
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Re Presentation
Give everyone a sheet of paper. 
Record computer questions.
Small groups to present your model prints. 
Help each other with constructon questions. 
Record additional questions on your sheets.
Collect sheets.
Due Friday: 
Completed Model with 60/30 Plan Oblique printed in Renderzone.

Computer Tutorial:  Class 22

Model Requirements
Construct Site and Context elements and their layers (Form-Z page 65)
Define Surface Styles (Syllabus page 52) 
Paint Brush:  Clear All surfaces.

Negative Elements
Construct a negative element and difference it from the Site. 
Paint the negative element White before you subtract.

Questions
Respond to questions. 
Review strategies.
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CLASS 23:  FRIDAY

Big Friday Drawing
Gesture drawings from projected images. 
Continuous line scribble. 
Time:  2 minutes each. 
Media:  Black Marker. 
Initials & date in the corner. 
Hang images on the wall for quick observations. 
Repeat Process.

Break:  15 min.

Direct Perspective
Draw in your sketchbook. 
HL in the middle of the sheet with VPs 10” apart. 
45° two-point perspective—lead edge in middle. 
6” cube with lead edge starting 1.5” below the HL 
2.5" to the sides of the cube.
Subdivide the right face into vertical quarters. 
Create a subdivision design on the left face. 
Creating a three-dimensioal cubic sculpture. 
Add line weight and shading to finish drawing.
Photocopy last two perspective exercises to hand in next class.

Re Presentation
Hand out small sheets of paper to record computer questions.
Small groups to present your model prints. 
Help each other with constructon questions. 
Record additional questions on your sheets.
Hang Plan Oblique prints on the wall. 
Make observations.
Review set of required prints.
Collect Orthographic drawings & Grade Sheets.
Collect Reflections
Collect questions.
Due Monday:  RePresentation Final 
Digital file and prints.
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Computer Tutorial:  Class 23

Form-Z
Present process for creating ortho lights and specifying them for the Isometric 
view.  Create light group named Ortho Lights (Syllabus page 52)
Go through process of setting up and svaing each required view.
Respond to shared questions:  Differencing volume from site.
Answer individual questions during class.
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CLASS 24:  MONDAY

Warm-Up Exercise
Work on Visualization Puzzles. 
Do any that look interesting and challenging. 
Time:  30 min.
Show finished puzzles.

Weekly Drawings
Return project grades. 
make any appropriate comments.
Quarter grades to this point.
Collect photocopies of last two perspective exercises.

Break:  15 min.

Re Presentation
Hand out sheets of paper. 
Problems you encountered in finishing the project. 
Form-Z questions. 
Collect papers.
Reflections in Sketchbook. 
Hours spent since Friday's class? 
Three things you learned from the project.
Everyone should have their renderzone 60/30 plan oblique & perspective. 
Gather in small groups. 
Which design changes most dramatically from plan oblique to perspective? 
How and why did they change? 
Hang all Plan Obliques & Perspectives on the wall.
Make observations. 
Discuss problems.
Identify those that change most.  Why? 
Reinforce the value showing yourself your design.
Make a copy of the reflections over break.
Collect digital files.
Due Next Class:  Final digital files and prints. 
You must have a set for your self.
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Break:  15 min.
Collect Reflections

Form & Space Re Dux:  Process
Introduce last project. 
Introduce the Process portion.
Discuss spatial analysis in terms of occluding edges and boundaries. 
Experiment with how to represent an analysis of a space to communicate its ex-
periential definition. 
Use a Floor Plan print. 
Outline the elements cut through. 
Choose a reference point in the middle of the arrival space. 
Draw the edges of space defining elements. 
Draw radiating lines through all occluding edges. 
Shade wedges to reflect the nature of the bounding surface within each wedge.
Due Next Class:  Occluding Edge diagram. 
Read Phase I of the Project statement.

Individual Help
Work with individual students to help with computer problems.
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CLASS 25 :  WEDNESDAY

Direct Perspective
30/60 shortcut setup using MPs to set width of cube. 
Finding sloped surfaces. 
Time:  40 min.

RePresentation
Collect final digital files.

Break:  15 min.

Re Dux
Review limits on changing design. 
Review element dimension alternatives.
Small groups to read each other's Occluding Edge diagtrams. 
Are diagrams correct & words identify response to design goals.
Hang Occluding Edge diagrams on the wall.  
Answer questions and make observations.
Do preliminaries for major space and entry diagrams. 
Discuss goals and ways of seeing if goals are met. 
How do you know where spaces stop?

Break:  15 min.

Re Dux
Review way fo finding horizon line in printed sperspectives. 
Shading of perspectives. 
Adding people to perspectives. 
Making notes. 
Don some preliminary work in class.
Review Alternatives requirements.
Work on Process stuff in class. 
Take a break when you need. 
Overlay and trace to generate ideas.
Due Next Class:   
Final for Evaluating Views 
Final for Occluding Edge Diagram 
Prelim for one Alternative

RePresentation
Collect final prints.
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CLASS 26:  FRIDAY

Big Friday Drawing
Designing 2D Compositions 
Refer to the end of the Drawing project.

Break:  15 min.

Re Dux:
Small groups to present their analysis and alternative. 
Key thing you learned from the analysis. 
Key thing you did to improve your design. 
Members provide suggestions.
Hang old Plan Obliques and alternative on the wall in vertical column. 
Make comments and observations.
Work in class on second Alternative. 
Spend about 45 min.
Due Next Class:  Phase I Final Submittal.

Break:  15 min.

Computer Tutorial:  Class 26
Preparing the Floor Plan for the Presentation

Form-Z
Define the plan view. 
Set Image Options 
Render the image in Hidden Line 
Export Image as TIFF file.

Photoshop
Open the file and save it in Photoshop format. 
Convert to Grayscale mode. 
Print plan to be able to scale. 
Scale plan and Change Image Size appropriately. 
Filling areas with Black. 
Crop Image 
Export in TIFF format.

Freehand
Specifying page size. 
Importing into Freehand. 
Changing color and reversing.
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CLASS 27:  MONDAY

Direct Perspective
Transfer with Diagonals. 
Time:  20 min.
Dimensioning Edges 
Finding perspective structure 
Time:  40 min.
Due Friday:  Read pages 35-40 in “Drawing Form”

Break:  15 min.

Direct Perspective
Work over form-Z drawing. 
Time:  30 min.

ReDux
In your sketchbook. 
Two most important things you learned about your original solution from the 
Phase I? 
Key design goal for your Form & Space Re Dux.
Small groups to present alternative proposals.
Hang favorite alternative on the wall. 
Get up close and look. 
Why do you think the designs have improved so much?
Make sure that you have copies of your analysis sets that are needed to com-
plete your digital model.
Photocopy reflections.

Break:  15 min.

ReDux
Collect Phase I materials.
Collect Reflections.
Comments or questions about Phase II 
Use examples on the wall to highlight key project issues.
Due Monday: 
Finish computer model, choose and light views.

Computer Tutorial:  Class 27
Moving objects. 
Duplicating lights.
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CLASS 28:  MONDAY

Direct Perspective
Circles in perspective. 
Sketch squares at different angles to hold circles. 
8 point circle 
12 point circle. 
Turn drawings to see circles on horizontal surface. 
Time:  40 min.

Break:  15 min.

Re Presentation
Return project evaluations and make comments.

ReDux
Return Phase I and make comments.
Hand out grades to this point.

ReDux
Show past presentations to critique and identify key issues. 
Key communication goals of the presentation. 
Key Design issues. 
Critique the examples.
Due Wednesday:  Preliminary layout for your final presentation. 
Full size and printed using tiling.

Break:  15 min.
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Computer Tutorial:  Class 28

Photoshop Selections, Fills & Actions
Use people to demonstrate.(01Raw.psd) 
Levels Adjustment 60 &120 
Rename layer 
Fix gaps using 9 point brush & Clone tool.
Making Selections (Pages 39 to 44) 
Magic Wand 
Selection Tool Options 
Saving a Selection 
Loading a Selection 
Drop a Selection 
Revise a Selection. 
Invert a Selection
Fills & Actions (Pages 35 to 37) 
Linear gradations. 
Action:  Expand Selection 
Action: Uniform Fill
Simple Fills:  4 Approaches.

Photoshop: Basic Collage Rendering Process (pages 53 to 58)
Exporting from Form-Z:  Export Image
Preparing the Form-Z Image 
Save as PSD 
Convert to grayscale 
Adjust values. 
Rename background layer. 
Select and delete the sky.
Adjusting Surface Values
Add entourage elements 
Locating entourage elements. 
Scale entourage elements.
Shading entourage elements.
Layer Mask (Pages 49 & 50) 
Hiding portions of entourage elements.

Freehand:  Printing with Tiling (Pages 35 & 36)
Estimating sheet size for tiling.  Running test. 
Tiling:  Check orientation setting in Preview.
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CLASS 29:  WEDNESDAY

Class Starts at 9:00

Form & Space Re Dux:  Phase III, Presentation
Small groups to present presentation layout. 
Ask each other about technical questions. 
Return to your seats. 
On slip of paper provided, record your name and any computer questions. 
Collect Questions.
Hang layouts on the wall. 
In you sketchbooks identify what you think are the key communication goals of 
the presentation. 
In your sketchbooks record design principles and issues that were addressed 
previously in the quarter that you need to keep in mind as you design the presen-
tation.
Choose two that respond more successfully to the goals and design issues you 
have recorded. 
Share with a neighbor.
Share observations with the class and discuss.
Make suggestions.
Due Friday:  Phase II Final Submittal
Class Starts at 9:00

Sketchbook
Due Friday.

Teacher Evaluation
Ask for volenteer and leave room.

Break:  15 min.

Computer
Respond to Questions.

Form-Z
Creating Textures
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CLASS 30:  FRIDAY

Class Starts at 9:00

Re Dux
Hang the presentationes on the wall. 
Hand out cards and to form small groups. 
Each group is to identify three presentations that they agree are successful and 
why.
Have each group pin a card by each chosen presentation. 
Discuss reasons each was identified.
Make any additional observations.
Collect Prints and Digital Files

Sketchbooks
Collect sketchbooks.

Break:  15 min.

Teacher Evaluation
Ask for volenteer and leave room.

Quarter Reflections
Record three new things that you learned while doing the Presentation phase in 
your sketchbook.
You have finished you first quarter at Cal Poly.  During the quarter you learned 
a great deal and experienced some successes and failures.  What can be learned 
from this past quarter that can improve the next.
Record in your sketchbook:
Two things that you can do next quarter that would make the experience at Cal 
Poly more enjoyable.
Two things that you can do next quarter that would help you improve the quality 
of your work in architecture.
Gather in a big circle and share your thoughts.
Make closing comments and announcements.
Resubmittals due by 5:00 pm on Monday here. 
See you in the exit interviews. 
Have a good break.


